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Getting started 
Auto PartsBridge is an online ordering and parts validation system for dealerships and their 
body shops.  

Some of the benefits for dealers are: 

 Receive online orders and requests for quotes from body shops 

 Retrieve and process orders for your body shops, increasing order volume and 
potential rebates 

 Automatic VIN and parts validation to ensure accurate parts orders 

 Ability for dealerships to quote against aftermarket (AM) parts to capture additional sales 

 Automatic calculation and display of potential profit on discounted parts 

 Ability to send parts to the Dealer Management System (DMS) 

 Access to the full Electronic Parts Catalogue (EPC) 

Log in and out 
Auto PartsBridge is an online application that is accessed from the Auto PartsBridge website.  

To log in to Auto PartsBridge: 
1 Go to the Auto PartsBridge website. 

2 Select your manufacturer. 

3 Type your user name into the User name field. 

4 Type your password into the Password field. 

5 Click Log In or press Enter on the keyboard. 

 

 To log out from Auto PartsBridge, click Log Out. 
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Configure settings 
When you log in to Auto PartsBridge for the first time, you must configure the settings for 
your dealership. Administrators must complete all steps of the Configuration Wizard.  

Non-Administrators complete the End-User Licence Agreement only.  

The steps of the Configuration Wizard include: 
1 Introduction: View the Welcome window. 

2 End-User Licence Agreement: Read and select the required checkboxes to accept 
the EULA and privacy policy.  

3 Company Details: Confirm or change your company name, address and shipping 
details. Make sure you enter a valid email address. 

4 User Accounts: Create additional user accounts within the dealership (if required). 
Type the user details into the corresponding fields and click Create.  

5 Add-Ons: Install add-ons, such as the Auto PartsBridge DMSi application.  

The Auto PartsBridge DMSi allows you to transfer parts to your Dealer Management 
System. Click Install DMSi and follow the prompts. You can also click Connect to test 
your DMS connection at any time.  

 
6 Finish: Click Finish. 
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Change settings 
The Settings window allows you to modify the settings for your dealership. You can also 
select your language in the Settings window. 

Administrators can access all settings, such as the User Accounts, Customer Accounts and 
Add-Ons. Non-Administrators can access the Company Details only.  

To add new user accounts: 
1 Click Settings. 

2 Click the User Accounts tab. 

3 Type the user account details into the corresponding fields. 

4 If you want to allocate administrator rights to the user, select the Set as admin. 
checkbox. 

Users with administrator rights can change all settings. 

5 Click Create. 

 
6 Click Close. 
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To add new customer accounts for body shops: 
1 Click the Customer Accounts tab. 

2 Click Add.  

3 Type the customer account details into the corresponding fields. 

4 Select Discount MSRP or Cost Plus from the Discount Method drop-down list.  

5 Type the discount percentage into the Percentage field.  

The percentage must be entered for each customer account. 

6 Select the Is Internal Bodyshop checkbox if applicable. 

7 Select a name from the Preferred parts interpreter drop-down list if applicable. 

8 Click Create Customer. 

 
9 Click Close. 

 

 To edit a customer account, click the  icon and make the changes. Then, click Update. 

 To view or update the shipping address, click Shipping Address. To return to customer 
details, click Customer Details. 
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Access orders and order information 
Body shops send quote requests and orders directly to the dealer. When the body shops 
send new or updated orders, you automatically receive an email notification.  

Access the list of orders 
After you log in, the list of orders sent by your body shops is displayed. You can view all 
orders, search for a particular order or filter by a specific timeframe.  

To view all your active orders: 
1 Select Active Orders from the View drop-down list. 

2 View the list of active orders. The following information is displayed: 

 Status: The status of the order, such as new and updated orders. 

 Date: The date that the order was last modified. 

 Account Number: The account number of the body shop. 

 Customer: The customer name of the body shop. 

 PO/RO No.: The purchase order or repair order number (if available). 

 Vehicle: The model of the vehicle. 

 VIN: The Vehicle Identification Number. 

 Estimate No.: The estimate number generated by the estimating system. 

3 Click a column heading and select the  icon to sort the column data. 

 
 

To search for an order: 
1 Type the search criteria into the Search box. 

2 Select the search type from the Search by drop-down list. For example, customer 
name or estimate number. 

3 Click Search. 

The search results will be displayed. 

 

 To filter the orders, select the timeframe from the Filter drop-down list.  

 To return to the list of orders at any time, click Orders. 
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Retrieve orders from body shops 
Dealers can initiate and retrieve orders instantly from their body shops using the Order 
Retrieval feature. The body shop must have authorised the dealer to retrieve their orders 
within the Auto PartsBridge Monitor. This feature is useful for dealers when body shops send 
an order via fax, phone or third-party ordering system. 

The Order Retrieval feature is only available for selected manufacturers. 

To retrieve orders from your body shops: 
1 Click Retrieve Order. 

2 Select Estimate No. or VIN from the drop-down list. 

3 Enter the details into the corresponding field. 

4 Select a name from the Body Shop Name drop-down list.  

 
5 Click Retrieve. 

The new estimates will be displayed in your list of orders. 

 

View order information 
The first step in processing an order is to open the order and view the customer and vehicle 
information.  

To view the order information: 
1 Click Open on the required order. 

2 Click Order Information. 

3 View the order details.  

4 View the customer details. 

To edit customer details, such as the discount method applied, click Settings and 
select the Customer Accounts tab. 

5 Click Close. 
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View vehicle information 
When you open an order, the VIN is automatically validated against the manufacturer data. 

To view the vehicle information: 
1 Click Vehicle Information. 

2 View the vehicle details from the estimate. 

3 View the vehicle details validated against the manufacturer data. 

 
4 Click Close. 

 

 To view notes associated with the order, click Order Notes. If a note has been entered 
for the dealer, the Order Notes button will be highlighted. 

 If the body shop sends an order without a VIN, contact the body shop and request the 
correct VIN or select the model details. 
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Validate parts and add new parts 
The quote requests and orders sent by the body shops consist of the required OEM and 
aftermarket parts for a crash repair. This provides the opportunity for dealers to quote on 
the aftermarket parts and add any additional OEM parts to the order.  

Dealers validate the VIN and parts data against the manufacturer data to ensure correct 
parts sales and less returns. 

Validate parts automatically 
When you open an order, the parts are validated automatically against the VIN.  

To validate parts automatically: 
1 Click Open on the required order. 

2 View the valid parts in the Valid Parts frame. 

3 If you want to view a valid part in the EPC, click View in the EPC column. 

 

Validate parts manually 
The valid part numbers are displayed in the Valid Parts frame and the invalid part numbers 
are displayed in the Invalid Parts frame. The invalid part numbers must be validated 
manually using the Electronic Parts Catalogue (EPC). 

To validate parts manually in the EPC: 
1 Click Find on the invalid part. 

The EPC will be displayed. 

2 Navigate through the Graphic Index to locate the OEM equivalent part.  

For more information on finding parts, refer to the Add parts section. 

3 Click the callout in the image. 

The part details will be displayed. 

4 Click the  icon to add the part to the order. 

The updated order will be displayed. You can provide a quote on the aftermarket parts. 

 

 To access additional information such as supersession or selective fit options, click the 
required icon in the Lookup column. 
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Add new parts 
The Electronic Parts Catalogue (EPC) allows you to add parts that were not included in the 
original estimate to the order. The EPC is exactly the same as the EPC used by your body 
shop customers. 

Use the Graphic Index 
The Graphic Index is a pictorial index of the major and minor sections of a vehicle.  

To use the Graphic Index: 
1 Click Add Parts in the Order screen. 

2 Click the required major section. 

3 Click the required minor section. 

4 Click the callout in the image. 

The part details will be displayed. 

If more than one part is displayed, click on the required part. 

  

5 Click the  icon to add the part to the order. 

6 To return to the start of the Graphic Index to add more parts, click the  icon. 

To return to the order, click the  icon. 

 

 To navigate the index, you can also use the drop-down lists at the top of the screen. 
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Search for parts 
The Parts Search panel allows you to search for parts by description or part number. You 
can enter the full or partial part number.  

To search for parts: 
1 Select the search type. For example, description. 

2 Type the search criteria and click Search. 

3 Click on the required part. 

The image will be displayed with the callout of the part highlighted. 

The part details will be displayed. If more than one part is displayed, click on the 
required part. 

  

4 Click the  icon to add the part to the order. 

5 To return to the order, click the  icon. 

To close the screen at anytime, click the  icon. 

 

 You can see in the Totals frame of the Order screen if the body shop allowed you to add 
parts to the order. 

 If a part has been superseded, click the supersession icon  in the Lookup column or 
Part Details panel and select the required part. 
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View or add labour items 
Auto PartsBridge allows you to display the entire estimate and view labour items. This may 
assist you to identify additional parts for the repair. The additional parts can be located in 
the EPC and added to the order.  

Labour items are displayed as aftermarket (AM) parts and therefore you are able to provide 
a quote for the corresponding parts.  

To view the labour items and add additional parts to the order: 
1 Select the Show entire estimate checkbox. 

The entire estimate including the labour items will be displayed. 

 
2 Click Add to Order on the required labour item. 

3 Click Find on the required labour item. 

The EPC will be displayed.  

4 Navigate through the Graphic Index to locate the part.  

5 Click the callout in the image. 

The part details will be displayed. 

6 Click the  icon to add the part to the order. 

7 Click the Show entire estimate checkbox again to deselect it. 

The estimate including the labour items that you have added will be displayed. 

 

 To add a note prior to sending the quote to the body shop, click Order Notes. 
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Send quotes and invoice parts 
Once the parts on the order are validated, a quote for the OEM equivalent of the 
aftermarket parts can be sent to the body shop. Parts that are ready to be ordered can be 
sent direct to the Dealer Management System (DMS). 

Send quotes to body shops 
Prior to preparing the quote, you need to check which parts are eligible for a rebate. As you 
enter the sell price on eligible parts the rebate and profit will be displayed. This allows you 
to easily view, adjust and maintain your profit while offering discounted parts.  
Note: Some manufacturers may not offer a parts rebate program. 
To prepare a quote for the body shop: 

1 View the order and identify the aftermarket parts.  
The information for each part includes: 

 PR: The eligible parts will be indicated in the Program (PR) column. 
 Part Type: The two types of parts are OEM or aftermarket (AM). The 

aftermarket type includes parts such as salvage parts, sublet parts and 
remanufactured parts.  

 Lookup: The additional lookup information includes supersession data, 
alternate part data, selective fit options or fitment instructions. 

 Est. Price: The Suggested Retail Price from the estimate. 
 MSRP: The Manufacturer Suggested Retail Price from the manufacturer price file 

in the EPC. 
 Cost Price: The dealer’s purchase price from the manufacturer. 
 Sell Price: The sell price from the dealer. 
 Profit: The percentage of profit based on the sell price. 
 Status: The OEM parts are labelled as Order and the aftermarket parts as Quote. 

2 Edit the price for each aftermarket part in the Sell Price field. 
Additional information, such as the estimated rebate and the profit amount will be 
displayed in the Totals frame.  

  
3 Once the quote is complete, click Send Quote. 

The quote and an email notification will be sent to the body shop.  
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Mark the parts as invoiced 
When a body shop confirms which parts, they wish to order they change the status of each 
part from Quote to Order. Then, they send the order back to the dealer.  
When the dealer receives the confirmed order from the body shop, the parts displayed with 
an Order status can be marked as invoiced or sent to the DMS. 
To mark parts as invoiced: 

1 Click Open on the Updated order in the list of orders. 
2 Check any notes and review the parts with an Order status. 
3 Obtain the invoice number from your DMS for each line item in Auto PartsBridge. 

4 Click Mark as Invoiced. 

 
5 Type the invoice number from your DMS into the Invoice Number field.  

The invoice number you enter in Auto PartsBridge must match the invoice number in 
the DMS for each part line. Unmatched parts may not be eligible for a rebate. 

6 Click Apply. 

If you need to add different invoice numbers for each part, enter the specific invoice 
number in the corresponding line item and click Apply.  

7 Click OK. 

The status of parts will change from Order to Invoiced. Move the mouse over Invoiced 
to see the invoice number and date. 

 
 To edit an invoice after the parts have been sent to the DMS, click Edit Invoice. You 

can edit the invoice for up to 10 days after the order date. 
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Send parts to the DMS 
Auto PartsBridge has the ability to send parts directly to the Dealer Management System 
(DMS). The parts displayed with an Order status can be sent to the DMS.  

If you do not have the DMS setup, you can mark the parts as invoiced. 

 
To send parts to the DMS: 

1 Obtain the invoice number from your DMS for each line item in Auto PartsBridge. 

2 Click Send to DMS. 

 
3 Select a part in the Transfer list and click Transfer.  

Each part is transferred one line at a time.  

4 Type the invoice number from your DMS into the Invoice Number field.  

The invoice number you enter in Auto PartsBridge must match the invoice number in 
the DMS for each part line. Unmatched parts may not be eligible for a rebate. 

5 Click Order Details to view the full list of parts and to enter the invoice numbers for 
parts that are on different DMS invoices.  

6 Click Apply. 

7 Click OK. 

The status of parts will change from Order to Invoiced. Move the mouse over Invoiced 
to see the invoice number and date. 

 

 If a body shop declines a quote, the part will be marked as Do Not Order in the Status field. 
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Track and manage orders 
Orders can be viewed, saved, printed and archived in the Orders screen. 

Orders are organised based on their status. 

Status Description 

 New Order A new order received from the body shop. 

 Updated Order An updated order received from the body shop. 

 Needs Action (Quote) A quote that needs to be sent to the body shop. 

 Needs Action (DMS)  An order that needs to be sent to the DMS. 

 Quote Pending A quote that is awaiting confirmation from the body shop. 

 Archived An order that has been archived. 

 

Orders can be accessed from the following folders: 

 All Orders: Displays active and archived orders. 

 Active Orders: Displays active orders and quotes. 

 Archived Orders: Displays orders that are closed and have been archived. 

 
 

 To return to the Order screen at anytime, click Order at the top of the screen. 
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Search for an order 
You can search for a particular order in the Orders screen. 

To search for an order: 
1 Type the search criteria into the Search field. 

2 Select the search type from the Search by drop-down list. For example, estimate 
number. 

3 Click Search. 

Print an order 
Orders can be printed from the Order screen. 

To print an order: 
1 Click Open on the required order. 

2 View the order. 

3 Click Print. 

Save an order 
Orders can be saved from the Order screen. 

To save an order: 
1 Click Open on the required order. 

2 View the order. 

3 Click Save Order. 

Archive an order 
Orders can be archived once finalised.  

To archive an order: 
1 Click Open on the required order. 

1 View the order. 

2 Click Archive.  

 

 To re-activate an archived order, click Re-open in the Orders screen. 

 To process supplements for a body shop, you can use the Re-import Order button. 
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Access the Rebate report 
Once the parts have been invoiced, the OEM must match the Auto PartsBridge order to a 
DMS invoice to ensure you receive the rebate on your conquest parts.  

The Rebate report allows you to easily track all the eligible parts that have been invoiced 
within the Wholesale program and whether the parts have been invoiced correctly. 

Note: This report wlll be available for manufacturers that offer a parts rebate program. 
 
The main statuses for invoices are: 

 Pending: Parts that have not been matched by the OEM yet or have not been 
invoiced correctly within the program period. 

 Matched: Parts that have been invoiced correctly within the program period.  

 Unmatched: Parts that have not been invoiced correctly at the completion of the 
program period. 

 
To access the rebate report: 

1 Select Rebate from the Report Type drop-down list. 

 

2 Select the parameters for the report and click the  icon. 

3 Review the invoice details such as the invoice status and the rebate information. 

You can also filter the report using the Filter drop-down list. 

4 Identify any pending invoices and check that the parts have been invoiced correctly. 

5 Make corrections to pending invoices within Auto PartsBridge or the DMS, if required. 
For example, ensure the following information matches between Auto PartsBridge 
and your DMS. 

 Invoice Number 

 Account Number 

 Part Number 

 Quantity 

 Typical Discount 

 Sell Price 

6 Generate the report again and confirm the status has changed to Matched. 
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